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A letter to the Desk of Editor

Hello friends!

We have started our Journey in the year 2010. We have completed successful three years of
publication of our magazine. In these years we got unconditional support from some renowned
SketchUp professionals to continue our magazine uninterruptedly. The lists are very big - Matt
Donley, Jim Leggitt, Nomer Adona, Daniel Tal, Jean-Luc Clauss, Bonnie Roskes, Mike Tadros, Evrim
Pekaslan, Bharath Musunuri, Paul Lee, Claudio Cosentino, Adriana Granados and many more. We
want to give special thanks to them for their cordial contribution towards our magazine. We can also
take pride as these professionals become the part and parcel of our magazine. We want to
widespread the usefulness for creating 3d models in SketchUp all through the world and these
professionals our inspiration to achieve our goal.

The most striking news of this month is that Trimble offers support for Survey & Engineering
Workflow with file integration in SketchUp. By implementing SketchUp import support, Trimble
Business Center aids surveyors to calculate points on the basis of 3D SketchUp Pro models produced
by engineers and architects and transmit those points into Trimble Access(TM) field software for
executing field activities. While commencing for design work, survey and engineering companies as
well as architects can make a up-to-the-minute & precious depiction of the land layout as the
Trimble Business Center's exporter functionality routes survey data back into SketchUp.

We have launched the June issue of our magazine. In this issue there is an exclusive interview
with Corey Rubadue (Product Manager of V-Ray for SketchUp). In this interview Mr. Corey has
shared his in-depth experience working with v-ray and also focus on sore interesting features of the
latest version i.e. V-ray 1.6 for SketchUp.

The team of SketchUp-ur-space has written an informative and fully fledged cover story analyzing
the brief features of SketchUp Pro 2013. The readers can know about the latest un-gradations and
enhancement with Trimble SketchUp.

In article section Belen Fernandez Franca, the renowned Technical Architect and Trimble Authorized
Trainer, has presented an interesting article on applying SketchUp to live mappings. The article is
associated with a live project which was executed at the "Barcelona Visual Sound 2013" festival.

There is also another highly impressive article provided by Frank Fheitzman, the noble instructor and
head of BIM program in Triton College situated in Chicago. The article will provide great benefits to
the SketchUp users as they will learn all the basics functionalities of SketchUp under one roof.

In tutorial section the most promising Architectural Designer and 3d Visualizer Myren June E.
Purificacion introduces an interesting tutorial on how to apply SketchUp for modeling and rendering
of the exterior of a 3 storied house.

In another tutorial, Matt Donley, the most experienced SketchUp master, has shared his valuable
experiences to show how people are generating hatches in SketchUp and how to apply the new
pattern fill feature in Layout with SketchUp Pro 2013. This tutorial will obviously help SketchUp users
for making various types of unique effects.

In blog section Leopoldo J. Tescum, an electrical mechanical engineering from Mexico, shared his
personal experience on how he became hooked with SketchUp and started utilizing SketchUp in his
projects.

In our blog section, there is also good information on E-on Software's latest product updates about
the availability of LumenRT 4 GeoDesign Plug-in. This newly launched product is packaged as an
add-on plug-in product for LumenRT.

In the news section our readers get latest information and happening with the 3d modeling world.



F

A SKETCHUP-ur-space

thee firat eoer Sheichiip moaganine

Hope our readers will find this issue useful to read and gather some good knowledge for
utilizing SketchUp in their work successfully. Please send me your suggestions at

rajib@SketchUp-ur-space.com.

Happy Reading!

Best Wishes
Rajib Dey
Editor
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Interview Corey Rubadue - Product Manager for V-Ray
for Sketehiap

Welcome to the arena of SketchUp-ur-Space. Make a brief introduction about yourself and
Chaos Group.

My name is Corey Rubadue and I'm the Product Manager for V-Ray for SketchUp. I'm also an
architect that has used V-Ray for architectural visualization either in practice, or by helping develop
that part of the product line for over 10 years now.

Chaos Group is a leading provider of innovative render solutions for a broad range of industries:
media, entertainment, architecture and design. Our main goal with V-Ray, our flagship rendering
software, is to bring speed, quality, reliability and ease of use to an artist's workflow. We frequently
partner with artists during our development process to ensure that every advance we make allows
them to push their creativity even further.

V-ray 1.6 for SketchUp is just launched and it is in beta version. When can we expect to
get the full version? Is Chaos group making any live presentation on this product?

We expect to release the final version of the product early this summer, and will be demonstrating
live at the AIA conference on June 20-22. To coincide with the beta release, we have also created
some great online demonstrations which can be found on our site and our YouTube Channel (please
see below). More will be created in the future - so look for updates in our newsletter and via our
Twitter and Facebook accounts.

http://www.youtube.com/watch?feature=player embedded&v=griCfFYME1Q

http://www.youtube.com/watch?feature=player embedded&v=UQvP9idQijo

http://www.youtube.com/watch?feature=player embedded&v=8tWtIQBHcSI

What crucial enhancements are included in V-ray 1.6 in comparison with other versions?

The core goal of V-Ray for SketchUp is to give artists the tools to create powerful work on their very
first try, and even more powerful work as they continue to refine and iterate. All of our new features
directly respond to that goal.

For instance, in this version we have introduced one of the most important features to come out for
SketchUp rendering: V-Ray Proxy. With it, users can share assets between applications and render
them directly in SketchUp without size limitations. The new V-Ray Dome Light, on the other hand,
dramatically improves the quality of lighting and shadows in visualizations through HDRI imagery. All
someone has to do to create a real world lighting environment is add a Dome Light, position it, and
you're done. Then there is V-Ray RT, our interactive rendering solution that brings real-time visual
feedback into every artists' decision process. Seeing choices appear on the screen in real-time
makes the whole creation process faster and more efficient, whether you are picking camera views
or adjusting individual material settings.

What problems are arising from the users while testing the beta version?

One of the problems that has come up is that 64-bit rendering was not supported with V-Ray for
SketchUp. We heard our customers loud and clear. In the second beta release we have introduced
support for rendering to a local 64-bit process as well as rendering to 64-bit distributed rendering
servers. This will allow our customers to break free of the 2GB RAM limit of x86 applications.

Another initial issue was that we found that even after doubling our server capacity in preparation of
this beta release, the demand was so high that we needed to quadruple it to keep up with the
download requests. Not a bad problem to have, and our users were incredibly gracious about it!

Do you provide any helping documents which will be useful to guide the users for testing
this beta version?
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Actually we've created several tutorial videos to cover the new features and updates. These will
continue to evolve as we continually adapt to our user feedback, and are available at:
http://spot3d.com/vray/help/sketchup/150PB/

What will be the price and how users can access the product?

The suggested retail price of V-Ray 1.6 for SketchUp is $800 USD, and the upgrade price for existing
users is $320 USD. It is now available on our website and through our great network of resellers,
which customers can search for (by country) on our website
http://chaosgroup.com/en/2/purchase.htmI?pID=10

With this release, we are also moving the V-Ray 1.6 for SketchUp license to a hardware key. This is
the standard for most V-Ray customers, and will unify our entire licensing system. It also means
that everyone can now conveniently store all of their V-Ray licenses on one device, which will lead to
greater efficiency and a much easier time for them when switching between design packages.

What types of works can be performed with V-ray for SketchUp?

Architects are using it to conceptually design their buildings, explore details, and present completed
ideas to clients and decision makers. Sometimes that's a skyscraper, and sometimes it's a remodel
of someone's kitchen. There are no limitations; artists can create a beautiful representation of
whatever space or structure they want. Recently we saw it put to good use when Jorge Barrero from
Genlser sent us renderings of a innovative interior space being designed for General Motors at
Epcot. http://www.chaosgroup.com/en/2/details.html?authorID=154&dP=2

Chaos Group has launched several version of V-ray for SketchUp users and among them
which version is best for rendering work & why?

We know artists use different tools in their workflow, so we designed V-Ray to be a valuable force in
every program an artist wants to work in. Sometimes a project starts in SketchUp and moves to 3ds
Max. Our hope is that V-Ray can deliver brilliant results, easily and at high speeds for the entire time
someone is iterating on an idea. We also believe that the work that you do in one package should be
available to you in another. V-Ray lives by this ideal, which is one of the reasons we make it for so
many design suites.

When Chaos Group first launch V-ray for SketchUp and how it is gradually developed?

After Chaos Group acquired ASGVIS, V-Ray for SketchUp officially became part of the Chaos Group
product portfolio. With that acquisition, we also saw a chance to up V-Ray for SketchUp's core
capabilities. Tools needed to become more efficient and easier for artists to use. The workflow had to
become refined. With V-Ray 1.6 for SketchUp we have addressed all of these concerns, so now we
are onto making it even better.

What up-gradations do you want to put in the future release of V-ray for SketchUp?

We are always in development on new ideas, and whatever comes next will always be a mix of
customer suggestions and company insights into where the future of rendering needs to go.

That said, we are hoping to implement GPU support for V-Ray RT. And of course, we are always
going to make sure V-Ray is compatible with all new versions of SketchUp.

Beside SketchUp, what other software will be compatible with V-Ray.

We proudly support the 3D community through our suite of software solutions:

V-Ray® for Autodesk® 3ds Max®

V-Ray® for Autodesk® Maya®

V-Ray® for Autodesk® Softimage®

V-Ray® for Autodesk® Cinema4D®
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e V-Ray® for Blender®

e V-Ray® for Cinema4D®

e V-Ray® for SketchUp®

e Phoenix FD™ Autodesk® 3ds Max®
e Phoenix FD™ for Autodesk® Maya®
e Pdplayer™

Who knows what the future holds, but you can bet, if our customers want V-Ray in a new place, we
are going to meet them there.
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Review of Sketehip Pro 2013

After SketchUp has been acquired by Trimble, the most significant development is that the
introduction of SketchUp 2013. In SketchUp 2013 there will be an ecosystem useful for SketchUp
modelers to acquire and apply the plug-in and extensions according to their choices. The new
version also contains the powerful documentation and presentation features in the formation of
Layout.

The previous brand of SketchUp free version is also changed. From now onwards the SketchUp free
version will be known as SketchUp Make. All the icons inside SketchUp free version contain new
look.

Trimble launches a new license agreement for the application of SketchUp Make. Trimble Navigation
Limited and/or its affiliates ("Trimble") offer the users a personal, worldwide, royalty-free, non-
assignable and non-exclusive license to utilize the executable version of the Software for non-
commercial utilization. Trimble does permit anybody to sell sell, rent, and lease or lend the output of
the Software or the Services. If anybody uses the software or service for commercial purpose,
he/she has to purchase a SketchUp Pro license.

In SketchUp 2013 the SketchUp users will find the most powerful Extension Warehouse. It is a
respiratory of add-ons, plug-ins and extensions allowing the users to get seamless searchable access
for all of them under one roof. The SketchUp users can customize and pull out their competences
from scheduling to 3d printing. For more information go through the link SketchUp Make License

agreement.

Extension Warehouse can be utilized to search, set up and update SketchUp plugins smoothly and
effortlessly.

It acts as the application store of a smart phone and contains great lists, user reviews, download
statistics, preparatory videos and lots more.

a0 Sketchllp 2013 - Skatchlp Pro

2l G/ B0+ B LK S()s
Meet Extension Warehou EE/‘__"—"/

By applying extension warehouse one can get rid of searching from a plugins directory, extracting
files and folders into proper locations in the file system. Inside SketchUp, one can avail a globe of
bonus functionalities updated by a radical ecosystem of developers.

Extension Warehouse also consists of an in-built installation manager which makes the installation
process easier. The user must contain a Google account with purpose of sign in and downloading
extensions.
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Extension Warehouse ™ ™
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In extended warehouse the toolbar visibility is also improved with a superior toolbar arrangement.
Now the users don't have to find each toolbar through the menu as a separate window will open to
select any toolbar. In order to view the toolbars just mark the checkbox beside a toolbar. Besides
the name, a line of text that explains how to apply the tool also becomes visible.

In SketchUp Pro 2013 there have been significant enhancements with layout features with the
inclusion of a full fledge presentation mode for LayOut for generating scaled, annotated, and
dimensioned drawings from models. The advancements are made in pattern fills, arrowheads, faster
vector rendering, superior zoom, more functional callouts and other developments.

For users of both SketchUp Make and SketchUp Pro, you have the additional new feature to export
MP4 (H.264), AVI, or WebM of your SketchUp Scene animations.

Patter Fills: Now SketchUp users will be able to use patterns and hatches to their drawings to fill
shapes in LayOut. Select from a extensive library of standard palette of patterns containing
construction materials, geometric tiles, dot screens as well as soil, steel, wood, rubber, concrete etc.
One can also form their favorite pattern by mingling solid colors with the patterns and import them
into their own library. The patterns are rotatable and scalable.

Copy Array: The SketchUp users will be in a position to generate numerous copies of an object in
SketchUp with the help of your keyboard. Also move a copy, type no of copies you require etc. Just
type the letter x and press enter.

Numbered Pages: Now users can keep tracing the pages, print and export with the help of pages
panel in Layout because pages panel now exhibit page number.

Improved zoom in capacity: The maximum zoom in capacity has been increased from 1000% (in
previous version) to 10,000% i.e accelerate up to 10 times. This feature will facilitate the SketchUp
users to detect the short line on their drawing more conveniently.

Faster Vector Rendering: In order to print a larger size drawing and generate a print with high
resolution, it is necessary to put the model render type to vector. It will help to transform the lines
showing smooth and minimize the load times for the most multifaceted models. The newly launched
version of LayOut vector rendering is faster than previous version.
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Video Export: The SketchUp 2013 contains a superior video export functionality which facilitates
the users to export high-class video animation of your scene in SketchUp in a smaller file. All the
videos will be made at 720p, prearranged in the most popular formats: H.264, AVI and WebM.

Dashes in Dimensions: In order to make precious details the dashes have been included to the
non-metric dimension labels in LayOut for smooth reading. It will be visible like 9'-1".

Arrowheads: LayOut consists of skinny and smoother arrowheads showing much better on
drawings with respect to the v8 interface. In 2013 version the arrowheads are created to arrange in
a line perfectly with their line segments.

Upgrade and Support: While purchasing a new license for SketchUp Pro 2013, the users are also
purchasing a year's worth of included upgrades (major and minor), email tech support, and phone
support for installation and licensing issues. If anyone already possesses a SketchUp Pro license,
requiring up-gradation to SketchUp Pro 2013, he/she can purchase the same Upgrade and Support
program separately. Get more details about it here: Upgrading to SketchUp Pro 2013.

SketchUp Pro is available at volume discount rates commencing from $495.00 (plus $95.00
subscription) for 1-4 licenses. One can download the new version of SketchUp containing with an 8-
day usage trial of the SketchUp Pro features.

You'll also want to check out some new video tutorials they have up on their Youtube channel.

SketchUp 2013 FAQ: If you have any query regarding the new license agreement, visit the faq
page to get answers to all your.

SketchUp Pro Support Policy: In this page, the users will acquire brief information regarding the
updated maintenance & support program for SketchUp Pro users.

SketchUp Pro License agreement: Official license agreement for new SketchUp Pro 2013 users.

http://www.youtube.com/watch?feature=player embedded&v=KKgGI-Hywxo

Downloadable link: http://www.SketchUp.com/download




A SKETCHUP-ur-space

” thee Firat aoer Bheichiip masasine

Sketehiap basiecs - Frank Fheltzmwma

Every architect needs to know how to use SketchUp!

SketchUp is free from Google just Google it and download to your computer. You can do just about
anything with it, but it is especially good for conceptualization of architectural design. The current
version (November, 2010) is 8.0. These instructions are based on this version. There is also a
professional version, SketchUp Pro 8.0, that they sell online for $495.00. Students can purchase a
one year license of SketchUp Pro for $49.00. But I would recommend downloading the free version
from Google.

The major difference between free and Pro version is the ability of SketchUp Pro to import from and
export into AutoCAD. If you really want to import AutoCAD drawings, you could download the
SketchUp Pro version for an 8 hour trial, import the AutoCAD drawing, and just not follow through
with your purchase. The earlier version, SketchUp 7.1, allows for using a free AutoCAD import plugin
that you can download from the Google SketchUp site. However, in order to import an AutoCAD
drawing into SketchUp 7.1, you need to first save the AutoCAD drawing down to AutoCAD 2007. The
AutoCAD drawing will import into SketchUp as a Group, which can then be exploded down to
individual elements, which, in turn, must also be exploded to be able to change them in SketchUp. It
is kind of a mess. It's really better just to redraw the drawing in SketchUp.

There are some great video tutorials online on the Google SketchUp web site. There is also an
extensive online library of SketchUp premade components which are available directly within the
program. SketchUp also plays well with Google Earth allowing you to not only design a building but
place it on its actual site anywhere on the earth.

1. Open SketchUp

2. If the screen is not set as shown below, make the following changes:
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Turn on the "Large Tool Set" Toolbar: Select the View pulldown menu >Toolbars>Large Tool Set
Turn on the "Views" Toolbar: Select the View pulldown menu >Toolbars>Views

Turn on the "Shadows" Toolbar: Select the View pulldown menu >Toolbars>Shadows

Turn on the "Styles" Toolbar: Select the View pulldown menu >Toolbars>Styles

Turn off perspective view for the start of the project: select Camera pulldown> Parallel Projection

10
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3. Go to the plan view by clicking on the Plan icon:

7

4. Your screen will look like this:

5. Draw a line: Use the pencil tool
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6. You can draw in X (red) or Y (green) or Z (blue) direction. If you want to make the line exactly
20'-6" long, pick the start point, then point the cursor in the direction you want to the end point to
be located then type in 20'6 on the keyboard. Inputting distances for lines is the same as AutoCAD:
click a point, then point the cursor in the direction you want to draw the line, then type the distance.

7. Note that the native units of SketchUp are inches, just like AutoCAD, in other words, if you type a
distance of 100 and do not put the foot symbol after it (') it will be interpreted by SketchUp as 100
inches. If you mean feet, type the foot mark ('). To separate fractions of an inch from whole inches,
leave a space.

8. At any time while you are drawing an entity, for example, a line or rectangle, you can type the
dimensions in the "VCB" box and the entity will be drawn to those dimensions.

Value Control Box (VCB)
Length 5' 1 178" 4

Tvpe i value and press Enter o apply the
vilue fo the active tool (no click required)

11
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e If you want to draw a line that is 9 feet 6 inches long, start to draw the line in the direction you
want, then type: 9' 6" (you don't need to click in the "VCB" box in order to type in it, just start
typing), and then press Enter.

e If you want to draw a rectangle that is 6 feet 6 inches wide by 4 feet 6 inches deep, begin to
draw the rectangle, type: 6' 6", 4' 6" (again, you don't need to type in the "VCB" box), and then
press Enter.

9. As you draw lines when a start or end point of the line aligns with another point, SketchUp will
signal graphically by drawing a red, green or blue line from point to point - like the illustration
below:

14. Draw a plane
e Draw a rectangle

e Change to a 3d view: select the isometric icon:

SR R l=Ra =k
1

e The drawing will look like this:

12
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e Select the Push-Pull tool:
v ay
XL
15
e F

e C(lick the left mouse button on the top face and pull it up. If you want to be precise about the
distance, type a number (add the foot mark if you mean feet).

e Turn on shadows:

13
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e Note that you can set the month of the year and the time of day for setting the sun direction.

e You can change the color of any modeled surface. To do that, select the Paint Bucket:

e Select "Colors" from the pull-down list:

14
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e Make sure that "Shaded" button is turned on:

ISR 1

e Select a color from the color palette and pick a plane that you want to color:

L
. ’MF"QHIE‘

15



A SKETCHUP-ur-space

” thee Firat aoer Bheichiip masasine

e If you turn the X-Ray icon on, also, you can see into the object:

19U TIVeW

S|

e Other ways of viewing your objects are "Wireframe," "Hidden Line," and "Shaded."

19. To move, rotate or scale an object, first select the whole object using the select tool .You can
pick one part at a time or select with a window or a crossing window. If you want to select several
parts one at a time, hold down the shift key. To unselect an a part of object that has been selected,
hold the shift key down and reselect it. If you want to cancel the selection, just right click the mouse
on a blank area of the drawing.

& ¢

Ftas ]

20. Then pick the "Move" or "Rotate" or "Scale" tool:

QX

&

21. To lengthen a line, click on the Move tool, click on the end of the line you want to lengthen
(there will be a green grip appear) and move it to a new location.

22. To copy an object, use the Move tool, but hold down the Ctrl key while moving.

16
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23. To mirror, select the objects, right click and pick "Flip Along" then select red, green or blue
direction. You cannot mirror along a diagonal axis, so you have to mirror first then rotate the object.
If you want to mirror an object and keep the original, make a copy of it first.

24. Saving: pick the Save icon or select File and then Save. The first time you save you will be
prompted for a name for the file as well as a location in which to save it.

25. How to draw a building with a gable roof.

e Draw a rectangle

e Extrude it vertically

e Draw a line down midpoint of one top edge to the other

e Use the Move command to drag that line vertically (along the blue axis)
26. How to draw a building with a hip roof

e Draw a rectangle

e Extrude it vertically

e Draw a line down midpoint of one top edge to the other
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Draw a square from one corner to the line

R 8]

el AN 3 B Nkt i -

] --I-
# et vl
L

- HE R
e —
an

T

P

e

i

L

o

ia

A

T

.

e e e et

Draw the diagonal of the square (45 degrees)
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Draw the other diagonal (45 degrees)
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Erase the square
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Repeat on the other side
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Grab the top ridge with the Move tool and move up (along the Blue axis)
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Bob's your Uncle
27. How to create Multiple Copies (Linear Arrays)
e The Move Tool can be used to create arrays, or a series of copies of geometry.

e To create multiple copies of one or more entities: Select the "Select" Tool. The cursor will
change to an arrow.

e Select the entities to be copied.
e Select the "Move" Tool.

e Press and hold the Ctrl key on your keyboard. This action informs SketchUp that you want to
duplicate the selected entities.

e Click on the selected entities to copy.

19
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Move your mouse to copy the entities. A copy of the selected entities will follow as you move
your mouse.

Click at the destination point to finish your copy operation. The copied entities are now selected
and the original entities are deselected.

Type a multiplier value to create additional multiple copies. For example, typing in 2x (or *2)
will create one additional copy (or 2 copies total, the one you manually copied plus one you
automatically copied using this step) instead of just one.

28. How to draw roads:

e Start with a large rectangle, which will be the ground plane
e Draw lines on it 25" apart.

e Connect the corners

e Draw an arc at each intersection

e FErase the excess

e Make closed at ends to turn into a plane

e Extrude 3' vertically down. (I know this is too large of a curb height, but we want to make a
visible depth to the road).

29. How to use the "Follow Me" Tool

Draw a rectangle 30' in the X direction and 40' in the Y direction.
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Pull it up 6'
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Copy these two lines by selecting them first, then select the move command, and pick the first point
as the bottom of the riser, the press and hold the control key down and pick the right end of the
horizontal line, then type x11. This will array the steps 11 times.

Note that the top portion of the cube can now be pushed and pulled separately from the bottom.
That is required to use the FollowMe tool.
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Select the FollowMe tool.
Place the cursor over the top part of the cube above the steps and click with left button.

Place the cursor and follow it along the top edge of the cube - you will see the edge line turn red.

Follow all along the left and far edge:

This is the result:
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Pretty cool - this takes some practice. So go ahead, practice!

Below is an explanation of the tools:

23



,*EE ETCHUP-ur-seacE

thee firat eoer Sheichiip moaganine

Select Tool Move Tool
Shift = Toggle Shift = Inference Lock
cri=Add M :: Ctrl = Copy
Shift+Ctrl = Subtract Alt = Auto-Fold
Right to Left = Crossing Selection VCB: Mumber = Distance
Left to Right = Window Selection
Paint Bucket Tool Push/Pull Tool

Shift = Matching
Ctrl = Connected
Shift+Ctrl = Object
Alt = Sample Paint

Double-Click = Repeat
Cirl = New Face
VCB: Distance

Q

Rotate Tool

Ctrl = Copy

VCB: Number = Angle
VCB: Rise:Run = Slope

Follow Me Tool
Alt = Use Parameter of Surface as Patt

Eraser Tool

Shift = Hide

Ctrl = Soften/Smooth

Shift+Ctrl = Unsoften/Unsmooth

Rectangle Tool
VWCB: Length, Width

Scale Tool

Shift = Toggle Uniform

Ctrl = About Center

VCB: Number = Scale Factor
VCB: Number w/ units = Length

Line Tool
Shift = Inference Lock
VCB: Number = Length

¥ ¢ ¢

Circle Tool
VCB: Number+s = Segments
VCB: Number+r = Radius

Offset Tool

VCB: Number = Length
Double-Click: Repeate

Arc Tool Orbit Tool
VCB: Number = Bulge Shift = Pan
VCB: Number+s = Segments Ctrl = Free
VCB: Number+r = Radius
Polygon Tool T Pan Tool
VCB: Number+s = Segments }." d
VVCB: Number+r = Radius '
Freehand Tool Zoom Tool

Shift = Draw 3D Polyline Shift = Change lNeld of View
VCB: Number = View Angle

VCB: Number in mm = Focal Length

D4 O \Ha
c

Tape Measure Tool Zoom Window Tool

Ctrl = Measure Only
VCB: Number = Resize Model

- F
-JJ

Dimension Tool ":!,3-.\ ) Zoom Extents Tool
X b
Text Tool Previous
Protractor Tool Walk Tool
Shift = Measure Only Shift = Move Vertically
Ctrl = Run

VCB: Number = Angle
VCB: Rise:Run = Slope Alt = Walk Through Entities
VCB: Number = Eye Height
Look Around Tool

VCB: Number = Eye Height

Section Tool

Axes Tool Position Camera Tool

> Q % BP

*% % B
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30. Shading and view commands:
ﬁ Iso
@ Wireframe
B
W
L TJ Hidden Line
'..'.f Front
Shaded
' ade B Right
ﬁ Shaded With
Textures ﬁ’ Back
oo ML

31. SketchUp and Google earth

You can place a SketchUp model anywhere on the earth using Google Earth. Here is how:
Open SketchUp

Draw a model in SketchUp

Import the site from Google Maps by selecting the icon in the SketchUp menu bar with the yellow
arrow pointing down.

e XYY X1 2
N’

An "Add Location" Dialogue box will appear:
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IIE.".:er an address or intersection Search |
! r U T

Type in the address of the location you want, and then click on "Select Region" button. You can then
adjust the pins at the corners and, then select the "Grab" button.

26



A SKETCHUP-ur-space

thee firat eoer Sheichiip moaganine

Cancel i Grah' ..

.".--q.qr'.

TN

FOWERED BY

Coogle

2

If you don't like the background, click on it so the border turns red, then right click and select
"unlock" from the context cursor menu. The border will then turn blue. Now select the delete key on
the keyboard.

Here is the original 3d image in Google Earth:

e O
e h 1[_.‘L|._
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Below is the image SketchUp after importing the Google Earth site to SketchUp:

You can move, rotate or scale your drawing on the Google Maps background, but you will not be able
to change the background. After you have the building where you want it, and want to see how it
will look in Google Earth in 3d, export it along with the site to Google Earth by selecting the "Place
Model" icon in the SketchUp menu bar with the orange arrow pointing up.

Now here is how your "placed" model will look in 3d in Google Earth:
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Note that you can continue to make changes to the model in SketchUp and then use "Place Model"
again to update it.

Do you want to reload file "C:
¢ \Users\Frank\AppDatatLocal\Ternph\SUPreview(.kmz" and lose any edits you've
made?

Yes ] | Mo | |Alwaj.rs (don't mkagainﬂ

Answer "Yes" to update the image in Google Earth.

Note that you cannot cast shadows in Google Earth.

32. SketchUP animations and Power Point

Open SketchUp and make a drawing
Create Scenes in SketchUp by selecting View>Animation>Add Scene

Zoom, move viewpoint, add color, change time of day or add to model in some other way and
add another scene.

After you have added all the scenes you want for your animation, select
File>Export>Animation. Give it a name and a path to save. It will save your file as an .avi file.
Open Power Point and make a new show.

Click on the Insert tab>Movie. Browse to the avi file you just created and select it. In the
Microsoft Office Power Point dialogue box that pops up "How do you want the movie to start in
the slide show," select the button "Automatically."

Frequently Asked Questions

Question 1: Why is my model being clipped and sliced as | rotate or zoom in?

1. This is a known glitch in the software called Camera Clipping Plane. First, don't worry;
although it can be distracting, this doesn't cause any actual damage to your model.

2. There are several situations in which you might encounter this:

3. One is when the field of view (FOV) is set very wide. You can adjust the FOV between 1 and
120 degrees (the default is 35 degrees in Google). It's easy to unintentionally change the
FOV by pressing the Shift key while you are zooming in or out using the Zoom tool.

4. Another situation that can cause clipping is when the Perspective camera mode is turned
off. In that case, click the "Zoom Extents" button (it looks like a magnifying glass with four
red arrows pointing outward). The camera zooms out to display the entire model, and the
clipping is eliminated.
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A third situation is when the scale of your model is very small or very large. In this case,
you can change the scale of your model.

This can also happen if your model is very far away from the origin point (the point where
the red, green, and blue axes intersect). In that case, you can move your model closer to
the origin point. To do this: select all of the geometry in your model, use the Move tool to
grab a corner point of the selected geometry that is on the ground plane, start to move the
selected geometry, and then type "[0,0,0]" (including the square brackets) in the "Value
Control Box" (which is in the lowerright corner of the SketchUp window). This causes the
selected point to be moved to the origin point.

I have found that the easiest way to fix it is to simply Zoom Extents (Camera, Zoom-
Extents, or Ctrl-Shift-E)

Question 2: How do | Change the scale of an entire model?

1.

If you have drawn a model composed of many entities, for example, an entire house made
of many edges, faces, and other entities, and then want to change the scale of the entire
model, there's an easy way to do this:

Pick an individual entity that you can use as a reference, for example, an edge that is about
six feet long, but that you know you want to be exactly nine feet long.

Select the Tape Measure tool and measure that edge from beginning to end. You should
see 6' displayed in the "VCB."

Type the length you want the edge to be, 9', and then press Enter.

A message asks, "Do you want to resize the model?" Click "Yes" to resize the entire model.
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Using Sketechiup for Live mapping - Belen Fernandez

Nowadays SketchUp is used in so many diverse professions and fields of work. In this article I would
like to show you a piece of work that was put together in collaboration with the "Punt Multimédia La
Casa del Mig" for this years, the 10th edition, Barcelona Visual Sound Festival.

The Barcelona Visual Sound Festival is held every year in Barcelona (Spain) during the spring,
combining competitions and free activities, fun and informative, related to the different areas of
visual artistic creation. For two weeks Barcelona Municipal Services organize and host competitions
and festival activities.

On the night of the 9th of May, during the closing of the days activities, a live Mapping
demonstration was projected on the unique facade of the building "La Casa del Mig", located in the
"Parc de I'Espanya Industrial" of Barcelona. It was a spectacular event ... where the fusion between
reality and video left many of the spectators speechless.

Picture of La Casa del Mig.
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3D View of La Casa del Mig made with SketchUp.

Picture of La Casa del Mig's Mapping.

This activity was organized by the "Punt Multimedia Casa del Mig" in collaboration with "Stereo Rent"
and "MediaFlow", major players from the world of international Mapping. You can see the live
Mapping herel!.

I provided for the event a scale digital mock of the "Casa del Mig" building. My team and I measured
up the building on site which was them drawn up to scale using SketchUp. Below are some pictures
of the building put together with SketchUp.
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3D view of the south facade made with SketchUp
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CMIG_madqueta_3.jpg
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The 3D model was used to prepare the mapping assembly which was screened live onto the front of
the building. With the use of the "Skp" files we could adapt the visuals to the unique contours of the
fagade.

~— zona audio

proyector 2 —,

g

zona arboles - zoma produccién | Z/ B o2

proyector 1 —

zona arboles

praector 1

Views of the 3D model used to prepare the Mapping assembly.
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Pictures of La Casa del Mig's live Mapping.

SketchUp also played an important role in the Mapping Contest held at the same Festival. With
SketchUp I put together the basic 3D structure on which the contestants screened their live

audiovisual creations.

Here are some pictures of the structure used by the contestants to prepare their Mappings.

r—.—

78,00 cm

k.

3D view of the whole structure made with SketchUp
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Picture of the real structure 2D view of the structure made with SketchUp Picture of the final real
structure

And some images of the live Mappings by three of the contestants.

You can see the live projections that were made by the contestants live on the facade of "La Casa
del Mig", on Youtube "Punt Multimedia Casa del Mig".

SketchUp for Mappings... Another use for this great software thanks to its speed and power.
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MYy storg with Sketch Up

My name is Leopoldo J. Tescum, I from Tabasco, México and I have a career in electrical mechanical
engineering and my interest in 3D began as a hobby, looking on the web any kind of 3D design
programs and installed in my computer which was not very good. While studying I liked make small
tutorials learning a little of everything. When I started working, I get in a project what we call METI
(Intelligent Tridimensional Electronic Models) that there is nothing other than an Oil Plant in 3D
modeling in a plant design program based in Autocad. The field job and then the modeling in the
plant design software give me a little experience with piping and all related. I find SketchUp 6 and
start to play with it, but I had nowhere to apply because my work was drafter in CAD.

Until in my recent job, I hear from a colleague that he wanted to make a software to evaluate
corrosion in pipes, but he want all kind of graphical an models in 3D illustrating examples, in that
moment I say that I have a program which i can help him showing a little example. From that, I
start to make sketch and drawings illustrating all kind of topic. Even when our project manager
wants to make a technical proposal to a client, he sends me a mail with a schematic and then I
translate his idea in a 3D image; SketchUp is a great tool and I continue learning and using to
enhance my work. I like search and read books and follow tutorials related to SketchUp and I looking
for a project that I can apply all my knowledge because I think that experience came from doing and
practice all the time.
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Guest post tips from Arne Salvesen for Sketehip

Arne Salvesen is a CKD (Certified Kitchen Designer) from Vancouver, British Columbia, Canada. He
writes the blog Useful Spaces that focusses on kitchen and bathroom design, and from time to time
good things to eat and drink. I had the pleasure of meeting Arne at KBIS, and he is such a nice guy.
In addition to his great design sense, he's also a Sketchup user. I asked him if he'd be interested in
doing a post for my blog, and he jumped at the chance. With one proviso: He had to be able to use
the Canadian spellings of words. Of course I agreed! You can follow Arne on Twitter [@arnesalvesen]

Eric has graciously asked me to do a guest post for Sketch This! It's truly an honour since Eric has
been one of my go-to guys for Sketchup for about a year now. But after he asked me for a
contribution, I wondered what could I possibly offer to someone who knows so much about this
terrific piece of software. Eric's advice: go with what you find useful.

For me, Sketchup's benefit comes in the form of speed. The functions contained within the
programme duplicate tasks I would perform while hand-drafting, and do so with more accuracy. Two
of my favourites are the "divide" and "multiply" functions. "Divide" is useful when you have a fixed
amount of space you want to divide into an equal number of spaces. To illustrate, I'm showing a bar
back panel that I want to make into a door style with five, equally sized recessed panels. I start by
creating some guidelines around the outside of my panel, set 3” (the width of my rails and stiles) in
from the edge. There's also a guideline on the left edge.
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To outline where my panels will be I simply select the first two guidelines and copy (not move) them
being sure to select the left guideline as my starting point. These guidelines are then placed so
select point lines up with the guideline set in from the right edge.
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To create my panels I simply type "/5”. This will make 5 copies of what I have just moved, and
space them equally over the distance I have moved them. Now I simply have to use the guidelines
to draw in my panels knowing they are all exactly the same size.
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The opposite function to this is "Multiply". Multiply is used when the space between a group of items
is the important part. A very common example of this is framing. Typically the framing member is a
wall are spaced 16” apart. Here, I show an object (representing a 2x4 framing member) being
copied in line to a new location. If I simply type in "16” while I'm moving the object, then hit the
Return key, the object will be moved exactly 16” (This assumes you're working in inches. If not, just
add " after 16 and you're set!).
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To repeat the move, simply type "*" followed by the number of times you'd like the move repeated,
and voila! Your wall is framed.
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E-on Software Announces mmediate Availability of
LUMENRT 4 Geobesign Plug-in

Leading Immersive Nature Solution Adds Seamless Integration with ESRI CityEngine

E-on software, the leader in 3D Immersive Nature technologies, today announced the immediate
availability of LumenRT 4 GeoDesign. Packaged as a add-on plug-in product for LumenRT, it delivers
the full power and capabilities of LumenRT Immersive Nature to users of ESRI CityEngine Advanced.

"This important new LumenRT add-on extends Immersive Nature to the emerging GeoDesign market
pioneered by ESRI CityEngine," said e-on Software CEO Nicholas Phelps. "It will allow city planners
and urban designers to breathe life into their designs with unprecedented ease and stunning
realism."

Win Business through more Engaging Experie

ESRI CityEngine Integration: Seamlessly integrated into ESRI CityEngine (the leading solution for
City Planning and Urban Design), LumenRT GeoDesign adds rich natural elements including wind-
blown plants and trees, moving vehicles, animated people, lights, water, and skies directly to
CityEngine scenes. Then, with a single command, the entire scene is transformed into an immersive,
interactive LiveCube™ allowing clients, customers, contractors, and colleagues to explore designs in
vivid photorealistic 3D.

High-Fidelity GeoDesign: With LumenRT GeoDesign, users can:

e Create urban scenes surrounded in a complete natural environmental context

e Perform lighting and time-of-day shadow studies

e Add wave-animated water such as ponds, lakes, and rivers

e Build detailed streets and intersections complete with moving vehicles and street lighting
e Design parks and forests with thousands of wind-animated trees

e Author attention grabbing videos and images for presentations

e Share designs with anyone using a PC or Mac
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Pricing and Availability: The LumenRT GeoDesign Plug-In retails for $195. It requires that
LumenRT 4 be installed as a prerequisite. It works with all versions of ESRI CityEngine Advanced
2010.2 or greater.

Visit www.lumenrt.com/purchase for detailed system requirements and purchasing options.
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Layout Pattern Fill § Hatehing with Sketchup Pro
2013

With the release of Sketchup Pro 2013 came the new pattern fill feature in Layout. Not only is this a
great solution for providing hatches in your Layout documents, but pattern fill can also be used for
creating a number of unique effects. I'm going to show you how people have been creating hatches
in Sketchup, as well as how to use the new Pattern Fill feature in Layout.

A Hatch is a symbolic pattern added to a drawing in order to help identify materials, objects, and
spaces. They also help define section cut planes. Architects have been doing this for decades. Even
before computer aided drafting they would draw in hatches by hand.

e Most hatch patterns are standardized, which makes them universally understood by whomever
is interpreting your drawing.

e Hatches help visually identify areas that represent materials or objects from areas that are just
empty space.

e Hatches help differentiate between material types. For example, different types of wood look
very similar to each other if rendered as a realistic material. However, if you use hatches to
define the different types of material, the hatches are easily distinguishable. This ensures
accurate interpretation of your drawings.

e Hatches help define the plane of a section cut.

e Hatches tend to communicate better when printed out on a black & white printer, as compared
to printing out realistic materials applied from Sketchup. Plus, they save on ink.

Using Sketchup to create hatches

When using the section cut tool, the cutting plane would expose the back faces of everything being
cut. There have been a few tricks people have used over the years in order to create hatches over
their section cut plane.

e The Poché Effect A trick featured on the SketchUpdate blog, this trick "fills" your section cut
with a solid black color. This is done by painting all of the interior faces of your model black, so
when the section cut exposes the interior of an object, you can't distinguish the faces from the
edges. This gives an illusion that the section cut plane is filled black.

e Interior Hatches Very similar to the first trick, instead of painting the interior faces solid black,
you'd apply a "hatch" material to the interior of the object. However, this is only effective when
viewing a section cut in orthographic mode from a parallel perspective.

e Create Group from Slice When you create a section cut, you can right click it and select
"Create Group From Slice." Then you can add faces to the slice by retracing the edges and apply
hatch materials (or colors) to those faces. This is the method used by Nick Sonder. He will
import the "section cut slice" as a separate viewport and place it on top of another viewport in
Layout. The tricky part with this method is you now have to organize all of the various groups
and scenes you've created, and if you change your model you have to recreate the section slice.
This process is made easier using theSectionCutFace plugin.

e Create Custom Hatch Style This is a REALLY cool way to create hatches in Sketchup. This
method was created by Michael Brightman, author of the new bestselling book, The SketchUp
Workflow for Architecture. I've read the book, I highly recommend it for people who are trying
to figure out how to effectively create construction documents using Sketchup & Layout. I've
personally learned a lot from the book. (Including this tip.)
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Michael figured out a way to use custom watermarks as a mask to simulate a hatch. Check out this
video. The best part about this method is that the hatch pattern is dynamic, meaning if you move
something in Sketchup, the hatch will move with it. Also, it keeps the same scale no matter how
much you zoom into the model.
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— Styles to create hatches

Despite all of these methods, there has always been a need for creating hatches in Layout. People
have been requesting pattern fill for a long time

Pattern Fill in Layout

The first thing you should know about the new Pattern Fill tool in Layout, is it's not exactly a "new
tool". It's actually an additional attribute to the existing shape style panel.

In previous versions of Layout, you could create a shape and assign it a fill color, and a stroke. (A
Stroke is the outline around the shape). Now, you also have the ability to assign a pattern to a
shape. It creates a tiled, repeating pattern within the confines of the shape based off of a raster
image. The pattern fill property retains transparency, so a pattern can be used as a mask, or you
can turn on the fill property of a shape to make the shape opaque.

My first instinct when I opened Layout 2013 was to click on the Pattern Fill window, select a pattern,
and apply it to different parts of my Sketchup model viewport.....Wrong.

Patterns can only be applied to shapes created in Layout.

As soon as I realized that the Pattern Fill was actually a property of a shape in Layout, I stopped
trying to apply patterns directly to my Sketchup model and figured out the right way to use it.

How NOT to use the Pattern Fill in Layout

e Do not try to apply patterns DIRECTLY to a Sketchup model in Layout. The pattern will
not do what you think it will do. (Try it)

e Do not explode your Sketchup model in Layout in order to apply patterns to the
resulting shapes.

e If you explode your model, it's no longer linked to your Sketchup file, and any changes made in
Sketchup will not be reflected in Layout, so you'll be forced to re-import the model, explode it,
and re-pattern it all over again. I also noticed that the resulting shapes created from the model
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created unexpected results in how they are filled.(If you feel like you're forced to do this, make
sure you are in Vector mode before you explode it)

Do not try to apply patterns as if it were a "tool".Pattern Fill is actually a style property of
Layout Shapes, just like Stroke and Fill. To create a patterned SHAPE, you use one of Layout's
drawing TOOLS (rectangle, circle, arc, line, etc.) to create the shape, then turn on the shape's
pattern PROPERTY. You can then adjust that shape's pattern STYLE using the Pattern Fill
panel. Confused? It's easy, see below.

The Right way(s) to use Pattern Fill

Aidan Chopra told me on my podcast that the intention for using the pattern fill is to set up your

Sketchup model like you normally would. Add a viewport of your model into Layout. Then, create
another layer and use the various drawing tools in Layout to trace over your Sketchup model. You
then apply patterns to the shapes you create in Layout.

Create shape, then apply pattern

Create a new Layer for your hatches, call it...."Hatches". (Or whatever)

Create a shape on your new layer using the drawing tools in Layout. Typically, you'd trace over
one of your Sketchup model viewports to create the desired hatch pattern area. Remember,
Layout will snap to points within your model to guide you.

Select the Shape

In the "Shape Style" window, click the Pattern button to apply a pattern. (If you don't have a fill
activated, you'll be able to "see through" the hatching. Most of the time you'll want to have a
white fill applied to mask out whatever is behind the hatched shape.)

Open the Pattern Fill panel to configure the pattern.
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[ |Basksmumaie
| Checkoerboand Black
* - / ] Circless Sickd Black
2. Configure the pattern in the Pattern Fill

Panel. This shape has a Basketweave at
2x scale, akcgigont o

In the Pattern Fill panel, you can select from a number of built in patterns. They are categorized into
geometric tiles, material symbols, site patterns, and tonal patterns. You can also create your own
tile images and add them to your library.

Once you've selected a pattern, you can also define the rotation of the image, as well as the scale.
You'll probably use the 45° rotation quite a bit. The scale will also come in handy to help you match
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the proportions of your viewport scale. Remember, you don't have to select a value from the drop
down menus, you can put any value you like in there.

Other ways to apply patterns

e Multiple Selection- If you have a lot of shapes to apply patterns too, it's no fun having to
select each one and configuring them one at a time. You could select multiple shapes at once
using the Shift key, then configure the patterns for all of those shapes at once.

e Configure Tool- Another way of doing it would be to configure the tool first, then draw the
shape. Whenever you activate any tool in Layout, you can configure the properties of that tool
before you start drawing. Then, anything you draw with that tool will inherit those properties.

e Drag & Drop- Layout has the ability to drag and drop patterns onto shapes. Just open the
Pattern Fill panel, click and drag the desired pattern onto a shape on the page to apply that
pattern to it.

e Sample another shape- Just like other shape style properties, you can use the eye dropper
tool to sample the style configuration of one shape, then "paint" that style configuration onto
another shape. You can also sample shapes to quickly configure a tool. For example, activate
the rectangle tool, then sample a shape with the eyedropper. Activate the rectangle tool again
and you'll notice it has taken the style properties of the sampled shape.

When to use Pattern Fill

Most of the methods for creating hatches directly in Sketchup require an additional level of
organization in order to execute properly. When you don't have the time to do that, creating hatches
in Layout can be a quicker, more straightforward approach to applying hatches. If you expect to be
changing the model quite a bit, however, it may be worth investing a little more time up front using
the Michael Brightman method described above since the hatches are dynamic.

Creating hatches in Layout can also be a great solution for defining spaces that are not represented
by 3D geometry. For example, ground planes are generally easier to represent in Layout.

Pattern Fill can also be used to apply screens or masks over objects in Layout. Try playing around
with some of the tonal patterns included in the Pattern Fill library. Using these patterns without a fill
will create a mask that can help you represent special areas of your model, such as "existing
structure, not to change".

You can also create masks that resemble a dashed line effect, allowing you to place other elements
on top of the model for better clarity.
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This effect was created using Pattern Fill -
as a mask, by selectmg a Tonal Pattern
and turning off F|II

H

Stud (beyond) ISy 0N - oo 13

2x6 Sill Plate \

Although there are plenty of tricks that will create a hatch effect in Sketchup, sometimes you just
need a way to do it manually in Layout. No, it won't be linked to your Sketchup model. And I wish
there was a better way to manipulate shapes once they were drawn (For example, multiple point
selection.) But honestly, this added feature is darn handy, and the end result does look really nice.
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Revizto for Sketehiap Tutorial v 1.2

Revizto for SketchUp allows you to convert SketchUp files into fully interactive navigated
environment. It has easy to use features such as material editor which enables you to create own
custom materials and apply to any other scene, lighting where you can instantly calculate light
maps, set local light sources and a sky box.

Watch the video and find out the main Revizto for SketchUp features.

http://www.youtube.com/watch?feature=player embedded&v=uBtssdgNnUA
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Sketehp Tutorial - Creating Curved Track Segments

I'm using SketchUp to create models for games. Currently I'm working on railroad track segments
for RollerCoaster Tycoon 3. I've made track segments before but they were quite easy to texture.
Now this is not the case with my current project as the trackbed is slanted.

I wonder what's the fastest and easiest way to create curves. Not only perfectly round curves but
also s-shaped curves and other ones where the radius is different at every point.

This is what | tried:

The follow me tool leaves it untextured.
The Shape Bender plugin doesn't map the textures.

The Fredo Scale's Radial Bending in combination with the UV Toolkit only works for curves with a
static radius.

The Perpendicular Tools (using a cross section of the model) needs manual UV mapping as well.

http://www.youtube.com/watch?feature=player embedded&v= EOQk-t5gEEg

57



A SKETCHUP-ur-space

thee firat eoer Sheichiip moaganine

Modern touse Ln Google Sketehiip - fast tutorial

This is me making modern house.

http://www.youtube.com/watch?feature=player embedded&v=c7TCPnOcp8c
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Dibac for Sketehiap

Dibac for SketchUp is a plugin for architectural drawing. It's a great tool for Architects and for anyone who wants to
draw architectural plans using 2D tools and then getting the 3D automatically.

You can draw walls, doors, windows, wardrobes and stairs, all dinamically created. And many more features will
come in future upgrades. Watch our video to see it in action.

Try the Dibac for SketchUp free trial now!

The promotional license will run without limitations until June 30th, then if you like it, you can support us by getting it
for just $39 or 29 € (vat excl.)

Dibac for SketchUp - Architectural Plug-in.

http://www.youtube.com/watch?feature=player embedded&v=IvyArqrU 20

http://www.youtube.com/watch?feature=player_embedded&v=y8SvXVWeLFs

http://www.youtube.com/watch?feature=player embedded&v=28TXylie5Qw
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Review: Raysupreme — Revolutionary 3D Modeling
and Rendering

I've always been fascinated by 3D modeling and rendering programs. Sadly, | am a "l want it now!" type of person,
and just didn't have the patience for learning how to create and place objects, and then wait for them to render. |
expected more of the same when | was asked to review RaySupreme from BrainDistrict, but | have to admit that |
was pleasantly surprised with this application.

B RaySupeme File Bl Objert Frojes View Heip W B WX TR 0§ 1R B O & B o WM EF Moajen I7 LEITPM ChrisHaws Q =T
.0 [T

Overview:RaySupreme allows you to create 3D modeled and rendered scenes in the same manner as most
programs of this ilk. You can select objects, change them to your liking, place them in the 3D "world", adjust their size
and position, and then render the scene. Pretty standard, right? However, RaySupreme allows you to design and
render your scene in a completely different, and fascinating way, by entering what you want to see via a text
description.

RaySupreme uses what they call "Text-to-3D" that allows even a rank beginner to create a detailed and well laid out
3D scene. Using Text-to-3D is easy. Objects, Materials and Scenes can be built, modified and arranged by English
descriptions. You can select specific types and styles of objects based upon your description. You can then use
adjectives to customize models, as well as building the models from different materials as the mood strikes you.

For example, following the help file BrainDistrict includes in the app to show how easy Text-to-3D is to use, | entered
the following into the app's Language Editor:

# Table

a table.
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# Left Side

a chair left of the table, facing the table.

a placemat on the left edge of the table, facing the chair. move the placemat 4 cm right.

a coffee cup on the back right corner of the placemat.

# Right Side

the same chair right of the table, facing the table. move the placemat 4 cm left.

a placemat on the right edge of the table, facing the chair. a coffee cup on the back right corner of the placemat.
# Vase

a vase in the middle of the table.

I then clicked the process language button and the following scene rendered in the rendering window:

a placemat = ke left edge of facing
a coffes cup L itfve back right cormer of

the chair right of facing the: table

E

.ﬁﬁ*“"ﬁﬁ'ﬁ‘ﬁﬂ fncing e s

wﬂ-vﬁ wﬁfﬁhw n’ﬁ-m

| then added the following to the "script":
#Time
Itis 1928AD

I then clicked the process language button, and the scene was updated to the following:
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a coffes cup = the back right comer of

thee: chair right of facing the table

As you can see, by setting a time period for your rendering, the application will update the objects in the scene to
reflect that time period. Very cool.

In addition to the Text-to-3D engine, experienced professionals can create 3D objects and environments. Primitive
objects in the application can be configured to suit the user's needs, and includes polygon-based modeling with a full
range of tools. Productivity tools such as Bend, Lathe, Extrude, and Shell are included.

As | said, I'm not an experienced user of 3D modeling applications, so | spent most of my time using the Text-to-3D
features, but | did have the opportunity to follow along with some of the included tutorials for the more advanced
features, and | was pleasantly surprised at how easy it was to understand the tools and how they are used.

BrainDistrict recently updated RaySupreme to version 1.1, and that is the version | reviewed here. New features in
version 1.1 include: 10 new modeling tools, Viewport background references, True point and spot lights, Global
cut/copy/paste functionality for geometry, render quality improvements, and more.

The app includes free downloadable materials to assist you in creating your screen. The library is continually being
updated, so make sure to update your local library via download from within the program.

Source: http://www.mactrast.com
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Trimble Extends Survey and Engineering Workflow
Support with Sketehiap File ntegration

New Functionality Integrates Native SketchUp File Support in Trimble Business Center Software

Trimble introduced today integration of SketchUp® file import and export capabilities in its Trimble®
Business Center office software. By supporting model data from SketchUp, Trimble extends its
capability to support survey and engineering organizations across their entire workflow. Acquired by
Trimble from Google in 2012, SketchUp Pro is used by architects and engineers to easily create 3D
models for visualization of structures.

As part of Trimble's suite of solutions, Trimble Business Center is the office software that fully
integrates with Trimble's field solutions allowing surveyors, engineers, and geospatial professionals
to edit, process and adjust data to produce high-quality deliverables.

"By adding SketchUp model support into our Trimble Business Center software, we further integrate
the survey and engineering workflow with processing and modeling capabilities," said Alain Samaha,
business area director for Trimble's Survey Solutions. "This integration can help ensure that survey
and engineering companies are working with reliable, accurate data and models to enable improved
productivity."

With the addition of SketchUp import support, Trimble Business Center now allows surveyors to
calculate points based on 3D SketchUp Pro models generated by engineers and architects and
transfer those points into Trimble Access™ field software for field work. Trimble Business Center's
exporter functionality routes survey data back into SketchUp and provides survey and engineering
companies and architects with a timely and accurate portrayal of the land layout as they begin
design work.

"The new workflow capabilities that this data interoperability path can provide are exciting. It can
enable increased collaboration between surveyors and construction design professionals, who can
now make compelling new 3D visualizations of projects that include realistic representations of
buildings and other such structures in real-world geospatial context," said Christopher Keating,
business area director for SketchUp. "In addition, precise survey data can now be efficiently
communicated from the field to the office, providing faster and more efficient design work in
SketchUp 2013 for new construction projects of all types."

Trimble Business Center v2.9 & v3.0 with SketchUp file support are available now through Trimble's
Survey Distribution Channel. SketchUp Pro 2013 is available for purchase through the SketchUp
online store, the SketchUp sales team or the SketchUp reseller channel. For more information about
SketchUp, visit: www.sketchup.com.
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Ruby Scripts - Add extra functlonality to Sketehip

Ruby is a programming language that anyone can use to write plugins (scripts) for SketchUp. Once
installed, Ruby Scripts can add tools, simplify multi-step operations, and otherwise improve the way
you work with SketchUp.

The good news is that you don't need to know anything about Ruby scripting (or programming in
general) to use Ruby Scripts that other people have created. To get started, you can find some pre-
made Ruby Scripts that we made, below. For links to even more, check out the Ruby Scripts section
of our Resources page.

If you're interested in creating Ruby Scripts for SketchUp, please take a look at ourDevelopers
page for more information.

For technical support assistance with these scripts, visit the SketchUp Help Forum.

Installing Ruby Scripts
To install a Ruby Script, here's what you need to do:
e Download it onto your computer.

e If the downloaded file is zipped, unzip it. You can usually do this by double-clicking on it.
Unzipped Ruby Script files have the following file extension: .rb

e Close SketchUp if it's running.

e Copy the Ruby Script file into the right location for your operating system: Windows:
C:/Program Files/Google/Google SketchUp 8/Plugins, Mac OS X: 'Hard Drive'/Library/Application
Support/Google SketchUp 8/SketchUp/Plugins

Using Ruby Scripts

The location of the controls for the Ruby Script you just installed depends on the Script; you access
some through the menu system, and others by means of right-clicking on elements of your model.
Some Ruby Scripts have their own dialog boxes, while others don't appear in the SketchUp user
interface at all - they're just "reference" scripts that provide functionality for other scripts. How you
use each script should be explained by its author, probably in the location from which you
downloaded the script.

Sample Ruby Scripts

Parametric: You need to install this script in order to use some of the others on this page.Download
'parametric.rb’

Mesh Additions: You need to install this script in order to use some of the others on this
page. Download 'mesh additions.rb'

Bezier: A tool for creating Bezier curves in two or three dimensions. Once installed, "Bezier Curves"
appears as an item in the Draw menu. Also a prerequisite script for ‘'onion_dome.rb’,
below. Download 'bezier.rb'

Rotated Rectangle: A tool for creating rotated rectangles with your mouse. Once installed, "Rotated
Rectangle" appears as an item in the Draw menu. Download 'rectangle.rb'

Shapes: A tool for creating and editing a number of parametric shapes: Boxes, Cylinders, Cones,
Toruses, Tubes, Prisms, Pyramids and Domes. Once installed, "Shapes" appears as an item in the
Draw menu. This script requires you to also install the following other scripts (see above):
parametric.rb, mesh_additions.rb Download 'shapes.rb’
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Window Maker: A tool for creating parametric double-hung and slider windows. Once installed,
"Windows" appears as an item in the Tools menu. This script requires you to also install the following
other scripts (see above): parametric.rb Download 'windows.rb'

Grids: A tool for creating parametric grids. Once installed, "Grid" appears as an item in the Tools
menu. This script requires you to also install the following other scripts (see above):
parametric.rb Download 'grid.rb'

Onion Dome: A tool for creating onion domes. Once installed, "Onion Dome" appears as an item in
the Draw menu. This script requires you to also install the following other scripts (see above):
parametric.rb, mesh_additions.rb, bezier.rb Download 'oniondome.rb'

Simplify Contours: Often, site contour data generated by a surveyor is quite dense (more than 5,000
edges). Applying this command to a set of imported contour lines simplifies the geometry, making it
easier to work with. Download 'SimplifyContours.rb'
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Blue Marble to Present at MAPPS 2013 n Rockland,
ME on 3D Flood Modeling Tool

Blue Marble Geographics (bluemarblegeo.com) has been selected to present on the COAST Tool at
the 2013 MAPPS Summer Conference. The conference will be held at the Samoset Resort in
Rockland, Maine on July 22nd - 26th. Blue Marble's geospatial data manipulation, visualization and
conversion solutions are used worldwide by thousands of GIS analysts at software, oil and gas,
mining, civil engineering, surveying, and technology companies, as well as governmental and
university organizations.

Blue Marble President Patrick Cunningham will be speaking on the development of COAST (Coastal
Adaptation to Sea Level Rise Tool). COAST is a free GIS-based tool for modeling and estimating
losses that are the result of sea level rise from climate change and storm surge. This modeling tool
allows GIS analysts to forecast the costs associated with potential flooding events, model strategies
to reduce those costs and publish this data in 3D Google Earth. COAST was developed by The New
England Environmental Finance Center (NEEFC), Catalysis Partners and Blue Marble Geographics and
is built on the Global Mapper platform. Global Mapper is a low-cost, GIS software solution developed
by Blue Marble. This talk will discuss some of the challenges faced with this type of initiative, as well
as explore the benefits of this type of specialized GIS implementation.

"We're excited to be presenting on COAST at MAPPS," stated Blue Marble President Patrick
Cunningham. "Not only is it (COAST) an effective use of GIS technology, but the story of the tool's
development is one of private sector and academia partnering to help businesses and communities
make cost effective decisions based on scientific research."
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Sketchiap at Maker Fatre

I will be attending Maker Faire in Detroit at the end of this month, I am really excited about it. I came
across this neat interview of all the uses of Sketchup at Maker Faire. Definite worth a spare few
minutes to watch!

http://www.youtube.com/watch?feature=player embedded&v=t8N0-Badlug
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BuildEdge for Sketehiap

There among the AEC software giants whose towering booths are metaphors for the huge buildings
they will help create, was Aaron Dietzen in a 10'x10' space showing off a little gem of an application
that does nothing more than make one of those giants (SketchUp) just a little easier to use. Make
that a lot easier to use if you are extending walls, making roofs, adding windows and so on.

BuildEdge makes a roof on a SketchUp model in no time flat.

Aaron shows me how BuildEdge is able to move a wall in SketchUp by dragging it. The adjoining
walls stay with the walls that move. This is because BuildEdge treats walls as enitites whereas with
SketchUp, walls are merely lines and surfaces. You may be used to that with your AEC software, but
SketchUp users were having to reconnect the wall manually. Every change involved some clean up.

As architects are all about billable hours, a few minutes saved from a couple of wall moves would
more than pay for BuildEdge -- it costs a mere $29! But there's more. BuildEdge brings more from
heavy duty architectural software into the SketchUp user realm. Making roofs is a cinch with
BuildEdge. Aaron shows me a house with 8 walls and BAM! A roof grows pops up on it. It looks nice -
- several peaks, edges, shingles. Sure, I've seen that being done in Revit and ArchiCAD, but
Sketchup users had to create that manually. It would have taken me hours. Also, windows
dimensioned from an edge keep their distance.
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But can it change the pitch of this part of the roof? Aaron does it in a wink. Before I can ask to
change a sloped roof to a gable, he does it for me.

Seriously, why isn't every SketchUp user doing building using BuildEdge?

BuildEdge is a plug in for SketchUp. Commands are accessed from a small menu window after you
install the program. It works with the free SketchUp and the professional version.

There is a trial version with limited capability avaialble on th BuildEdge site. Yeah, it doesn't do
windows.

For more information, go to http://www.buildedge.com/
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480 Thea Presto GPU Rendering for Sketchiap

Thea Render v1.2 and it's new GPU plugin Thea Presto were finally released late last week. This
update to Thea Render is the most comprehensive to date with the whole UI within Thea Render

Studio getting some attention and of course there is the new GPU rendering ability for nVidia CUDA
enabled cards.

GPU %Herﬁnﬁ?
SketchUp

See the promotional video here and grab it while it is discounted by 35%!
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Slkeeteh Up ur Space - The Creative Team

Rajib Dey
rajib@SketchUp-ur-space.com

Rajib, the editor-in-chief of SketchUp ur Space magazine is the main writer. He is responsible to write the cover
story, blog and many other columns. Along with it, he is creating a liaison between the writers and the readers.

Manoj Kumar Singh
manoj@jobs2india.com

Manoj is enthusiastic helps to put the content of the SketchUp up Space magazine in the html version. Manoj is the
html developer who beautifully creates each and every edition with care along with the PDF version.
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